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Step 4: Editing your own video (post-production) 

 

4.1. Editing 

The most important element of editing is the software you use 

combined with the experience and skill of the person doing the 

editing – and this will come with practice. Some of the 

approaches described below will depend on the software you are 

using – this information is based on Windows Movie Maker 

(WMM) – and others are applicable whatever software you use.   

 

First of all, never work without a storyboard. It will not only help you plan and 

organise your ideas and shots before filming, but also save you time when it comes 

to editing. 

 

Second, before you even start to run your video editing software, it is very important 

to organise the video, audio and photo files you produced when making your 

video.  Sort and review all the files you shot and mark those you really intend to use 

during editing to create your final video. It is good practice to make a folder with all 

your selected clips, from which you can import, to a so-called Timeline, all video files, 

audio tracks and images you’ll be using. 

 

Taking time to organise your selected shots will help you accelerate the video editing 

process, give you a clearer picture of your final product and save you time having to 

keep going through your raw materials.  You will also know how many materials 

(seconds) you have, and whether you are missing anything.    

 

4.2. Using editing software 

Learning to edit videos can be challenging.  It is quite a long process, so we 

recommend you start with a simple editing software. Look for something that is 

not overloaded with fancy, or advanced options or with too many extra tools, rather 

to help you to clearly understand basics of video editing process in a simple way. 

 

4.2.1 Windows Movie Maker (WMM) 

Windows Movie Maker (WMM) is a software preinstalled with earlier versions of 

Windows (XP), but it is also downloadable from the Microsoft website for newer 
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Windows version, which makes it easy-to-get free video editing software. Many 

users recommend WMM as a good editing software to start with. It offers many 

simple options and has easy-to-understand settings for beginners, together with 

support for a number of different video formats.  

 

Unlike many other editing softwares, WMM is free.  There are a lot of online tutorials 

to help you learn, it is very easy to install, functional and does not require an 

advanced or expensive computer.  

 

4.2.2. How to add video or photo to WMM 

When WMM is installed, click on the ‘Click here to browse for videos and photos’ 

button (circled in red in figure 1). This allows you to browse your computer and pick a 

video file. Also directly dragging and dropping files onto project main window is 

possible. 

 

Figure 1: 

 

 

 

4.2.3. Timeline & canvas 

WMM Interface is basically organised into three parts. The header at the top of the 

screen, containing commands, tools and options applicable to the video clip you are 

editing.  
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The canvas is placed on the left, below the header. It is one of most important 

windows in editing software. It looks a lot like the viewer, but its job is simply to 

display the frame you're currently on in the timeline. It is where you view your edit, 

how it currently look like. When you want to see what you've done, you can do that in 

canvas window, by pressing play button like in a video player.  

 

The Timeline (on the right) is where you do your editing. The final video is created 

on the timeline by dragging into, and then by editing and arranging your raw video 

clips, music tracks, images, stills, captions. The best advice here would be - don’t be 

afraid, import your first video clip, trim it in order to start at the point you wish, delete 

any redundant parts of the video after the trim/split, add some captions, apply some 

transition etc..  In general, use options offered in the header line above the timeline, 

play with the tools, try to make something, try many times and success will come! 

 

 

Figure 2: 

On the left side is the canvas window, on the right you’ll see timeline sample, while 

all the commands and tools are settled above those two windows. 

 

 

 

4.2.4 Which shots to choose  

Good preparation before and during video shooting will make this part of the job 

much easier (see 4.1).   
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Tips on identifying and selecting the clips and materials that will 
work technically and make your video look good 

  
1. Choose frames where objects are well positioned 

The positioning (framing) of an object is very important. It's usual that object you 
are filming is placed in vertical centre of scene. However, another well recognised 
technique is the  so-called, ’rule of thirds’, where the object is placed on one of 
two vertical lines that splits scene in three same-width segments, as shown. 
Which side you chose is determined by the direction the object is moving or by the 
direction a static object is looking.    

 
2. Choose well-lit shots 

If no additional lighting resources are available, choose scenes with even lighting.  
Avoid shots with shadows or extremely strong light (like summer sun), as well as 
very dark corners (noisy shoots with low light look and sound very 
unprofessional!).   And avoid shots where the light source is placed directly behind 
your object i.e. in front of camera (backlight).  Often backlit shots often result in 
uncomfortably bright light haloing a dark figure with no visible features.  

 
3. Prefer clips containing creative content.  

Change your shot angles, try to film both close-ups and wide shots, combine 
different perspectives and lightings… learn about rules accepted in video 
production sphere, respect them but at the same time - be creative!  

 
4. Editors love short clips! 

Instead of making one long file, stop and restart recording (at logical points). It will 
save time you’ll need for editing; smaller files are easier to handle.  
 

5. Good audio clips - go ahead (others stop). 
Audio is an important part of your video.  Keep audio levels between too silent and 
too loud,  so using a separate microphone when filming and placing it close to the 
audio source will help give your video good quality audio to edit from.    
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4.3. Adding voice over and music 

The soundtrack (audio) that accompanies your video can include a music track, the 

voice recorded simultaneously on your video file, or be a separately recorded 

soundtrack either recorded in an audio-studio or on a dictaphone and added as a 

voice over.  

 

If the audio is recorded together with the video, its symbol will appear under the 

timeline when you import it into WMM.  

 

If you want to add a separate, audio only file into your video using WMM it should be 

recorded / encoded into one of common formats, like mp3 or wav.  

 

The best way to add your voice over into WMM is to click the ‘Add music’ button from 

Home tab (see Fig. 3). Once a window appears, browse the computer and pick 

chosen voice over audio file. 

 

Fig. 3: 

 

 

Once chosen, the audio track will appear under the video layer (see green line in Fig 

4 below). By default, when you add an audio, it will be placed at the beginning of 

timeline. If you'd like to add music elsewhere in the timeline, you can click audio file 

in timeline and drag it to desired position. 
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Fig. 4(a): 

Default position of audio file.   

 

 

 

 

Fig 4(b): 

Audio file position after dragging it to a new 

position. 

 

 

 

 

 

 

 

 

 

 

 

The Options tab on the ribbon, under Music Tools, gives you access to some audio 

editing tools.  

 

 You can adjust volume of entire clip, using available slider by clicking on the  

Music Volume icon 

 Clicking the Fade In/Fade out allows you to fade in or fade out at beginning or 

end of the clip at three speeds: slow, medium or fast 

 Set start time: Accept the dragging+moving audio layer on the Timeline. This is 

another way to set the start of your audio track. It defines at which time in the 

video the selected sound will start playing  

 Set start point: This changes the point within the audio file at which the clip 

begins playing. For example, if you want to skip the 30-second introduction, or 

have a few seconds of silence before a song starts, you can change start point. 
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Fig 5: 

Audio editing tools 

 

 
 

4.4. Adding sub-titles  

(See also translation template in Appendix 6) 

At the Home tab, please locate and click on the ‘Caption’ icon. A new layer will 

immediately appear beneath the video layer appears. Here you have the option to 

change the starting position – the point where it will appear in the video, its duration, 

sub-title/caption content and style formatting.  

 

Fig. 6(a): 

From this position the sub-title will appear. 
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Fig. 6(b):          

By clicking “Caption” a text will appear. 

 

 

 

 

Now your subtitle text will appear.  

Enter your desired text here. In the 

Format tab, you can format and 

reposition typed text exactly as you 

want. If you've ever used Microsoft 

Word, this should be very familiar to 

you. You can preview changes in the 

left window (Canvas).  

 

 

 

Fig 6(c): 

Except when changing fonts and design, you can choose the duration of subtitles by 

clicking “Text duration” and choose the length in seconds. There are a few different 

text effects, so you can choose how you want your text to appear (cut, fade, fly in, 

zoom in…) 
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4.5. Transition between video clips, animating still images 

The Animations tab on the ribbon contains two different kinds of animation that can 

be added to video clips or still pictures: Transitions and Pan and zoom 

 

In video editing a transition is the kind of effect you will show between two video 

clips; i.e. ‘Cut’ will switch to the next scene without any additional visual effect, while 

‘Slide’ will move a previous scene out of the visible part of the video, whilst 

simultaneously bringing the next one into the video.  

 

 

Fig. 7: 

After the second clip is added, a different transition between these clips can be 

chosen. 

 

Once you’ve applied a transition, the clip in the timeline becomes a grey looking 

diagonal region that shows where the transition begins and ends (see Fig. 7). You 

can alter how long the transition takes by changing the Duration to the right of the 

Transitions gallery. After applying a transition to a clip or photo, select it and enter a 

duration time between minimum 0.25 to a maximum of 2.00 seconds. 

 

On the right-hand side of the Animations tab is the Pan and Zoom gallery. These 

can be applied in the same way as transitions, i.e. on your images: add a photo to 

Timeline then choose a pan and zoom setting from the gallery. In this way, your still 

image will move effectively (Fig. 8). 
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Fig. 8: 

Above the image there are different pan and zoom directions to choose 

 

 

 

4.6  Timing 

Less is more – aim to make your video two to three minutes for maximum impact.  

Certainly no longer than four minutes! 

 

4.7  Titles 

Opening title  

 Does your video have a title? 

 Do you want to show the written title and any other wording or a still image before 

your film starts? 

 Do you want to show some shots before the wording comes up? 

 

Remember you need to capture the attention of your audience in the first eight 

seconds! 

 

End titles 

 Is there a final message that you would like to write at the end of your video? 

 Who do you need to acknowledge? 
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If you want to add your organisations logo it should be in Vector format or PNG file, 

but it must have a transparent background 

 

4.9  B-roll 

B-roll is the name given to the supplementary footage used to help tell your story.  

This includes shots such as locations, any assistive technologies or other products 

you might want to feature, or people in wheelchairs demonstrating their inability to 

access public places because there is no alternative to stairs etc.   

 

If the topic of your video might be of interest to a television programme, they might 

ask you for B-roll, rather than the final edited version of your video.  B-roll does not 

include sound so that customised voice over or music can be added by the television 

producers.   

 

If you anticipate the story you are telling in your video might be of interest to a 

television company, you might consider shooting it in high definition. 

 

 


